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TREND IQ5 BMS Controller Platform

Product Information

Specifications

Product Name: IQ5, IQ5-IO

Model Number: Not specified

TREND IQ5 BMS Controller Platform Instruction Manual

Manuals+ —  User Manuals Simplified.
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Installation Instructions: Configuring

Manuals Included: IQSET Manual, IPTool Manual, IQToolMonitor

Applet Manual, IQToolAddresser Applet Manual, IQ5 Configuration Manual

Supported Networks: Ethernet, RS-485, T1LIObus, IQ3/4 IObus, USB

Terminator Switches: RS-485 networks

Product Usage Instructions

Before Starting Configuration

Prepare the Ethernet Network(s)

If the IP address settings (IP address, subnet mask, default router, WINS and DNS servers’ addresses) are to

be supplied by a DHCP server, ensure one is installed on the Ethernet segment to which IQ5 is connected.

Additional Documentation Required

IQSET Manual

IPTool Manual

IQToolMonitor Applet Manual

IQToolAddresser Applet Manual

IQ5 Configuration Manual

Note: PDF copies of the manuals are included with IQSET installation in the following folder: C:…Trend Control
Systems Documentation

Install DNS Server

If email alarms are to be sent and the email server address is identified by internet domain name, a DNS server

must be installed. Note that IQ5 does not support WINS. If hostnames are to be used, then a DNS server is

recommended. For security, the use of LLMNR protocol is not advised.

Configuration

Isolate All Power (including any I/O supplies)

Make sure to isolate all power supplies before touching any connected leads.

Open Panel / Enclosure

Be cautious as opening the panel may expose dangerous voltages.

Peel Off Serial Label(s) and Retain

Remove the serial label(s) from the front panel and retain them. Leave the front panel protective film in place.

Disconnect All I/O from I/O Modules

Disconnect all I/O connections from the I/O modules, but leave IQ5 Power, Ethernet, RS-485, T1LIObus, IQ3/4

IObus, and USB connected where appropriate. Make sure to isolate all power supplies before touching any

connected leads.

Set RS-485 Terminator Switches (if RS-485 networks are connected)

If RS-485 networks are connected, set the RS-485 terminator switches accordingly.



Configure XCITE/IO Modules (where fitted)

If XCITE/IO modules are fitted, follow the installation instructions for configuring them.

Connect Engineering PC/Laptop (with IQSET installed)

Connect your engineering PC or laptop to the IQ5 using either an Ethernet hub/switch.

FAQ

1. Q: Where can I find the additional documentation required for configuration?

A: The additional documentation, including the IQSET Manual, IPTool Manual, IQToolMonitor Applet Manual,

IQToolAddresser Applet Manual, and IQ5 Configuration Manual, can be found in the following folder: C:…Trend

Control Systems Documentation.

2. Q: What networks are supported by IQ5 and IQ5-IO?

A: IQ5 and IQ5-IO support Ethernet, RS-485, T1LIObus, IQ3/4 IObus, and USB networks.

3. Q: Do I need a DHCP server for IP address settings?

A: If the IP address settings (IP address, subnet mask, default router, WINS and DNS servers’ addresses) are

to be supplied by a DHCP server, then it is recommended to install one on the Ethernet segment to which IQ5

is connected.

Important: Retain these instructions
These instructions shall be used by trained service personnel only. If the equipment is used in a manner not
specifi ed by these instructions, the protection provided by the equipment may be impaired.

https://partners.trendcontrols.com

BEFORE STARTING CONFIGURATION

Install the IQ5 and any required I/O Modules

https://partners.trendcontrols.com


IQ5 Installation Instructions – Mounting (TG201482)

IQ5-IO Installation Instructions – Mounting (TG201484)

IQ4/IO/.. Installation Instructions – Mounting (TG201342)

XCITE/IO/.. Installation Instructions – Mounting (TG200627)

Prepare the Ethernet Network(s)

Install DHCP Server

If the IP address settings (IP address, subnet mask, default router, WINS and DNS servers’ addresses) are to

be supplied by a DHCP server, ensure one is installed on the Ethernet segment to which IQ5 is connected.

Install DNS Server

If email alarms are to be sent, and the email server address is identified by internet domain name, a DNS

server must be installed.

Note: IQ5 does not support WINS. If hostnames are to be used, then a DNS server is recommended. For

security the use of LLMNR protocol is not advised.

Install IQ®SET on Engineering PC / Laptop

IQSET Manual (TE200147)

Additional Documentation Required

IQSET Manual (TE200147)

IP Tool Manual (TE200638)

IQTool Monitor Applet Manual (TE201298)

IQTool Addresser Applet Manual (TE201299)

IQ5 Configuration Manual (TE201486)

Note: PDF copies are included with IQSET installation in the following folder: C:\…\Trend Control
Systems\Documentation

CONFIGURATION

 Isolate All Power (including any I/O supplies)

WARNING Connecting leads may be connected to power supplies. Isolate before touching.



Open Panel / Enclosure

WARNING Opening the panel may expose dangerous voltages.

Peel Off Serial Label(s) and Retain  (leave front panel protective fi lm in place)

Disconnect All I/O from I/O Modules



WARNING Connecting leads may be connected to power supplies. Isolate before touching.

Leave IQ5 Power, Ethernet, RS-485, T1L IO bus, IQ3/4 IO bus and USB connected (where appropriate).

Remove terminal covers

Unplug connectors

Refi t terminal covers

Installation Instructions – Configuring

Set RS-485 Terminator Switches (if RS-485 networks are connected)



Configure XCITE/IO Modules (where fitted)

XCITE/IO/.. Installation Instructions – Configuring (TG200627) Section 2 Only

Connect Engineering PC / Laptop (with IQSET installed)

Either: via Ethernet Hub/Switch

Or: using direct connection



Note: A connection via the USB Local Engineering Port cannot be used at this point.

Switch On Power to IQ5 (including any additional T1L IO and IQ3/4 Bus PSUs)

Wait for Controller to Boot Up

Check IQ5 Status Indicator

Set Display Language on IQ5-IO HOA Modules (if required)



Note: To change the language after initial setup, reset the module by following the procedure in section 7 on page
20.

Check Status of T1L IO Bus (only if IQ5-IO modules are connected)

Normal operation indication

Bus is connected and working correctly.

Bus is not connected (no T1L modules).

Fault indication

Bus is connected but not working correctly. Check the bus wiring and that all IO modules
are powered ON.

IQ5-IO Modules



Normal operation indication

Bus is active on both sides of the module

   

Bus is active on

left side only

Valid for the last module on the bus.

For all others, check wiring on the side that is unlit.

 

Bus is active on

right side only

Fault indication

   
No valid T1L connection. Check the bus wiring.

Check Ethernet Indicators (for any connected ports)



Note: The indicator will fl ash when data is being transmitted or received.

Connect to IQ5 using IP Tool

Using the PC/laptop (see step 7) run IQSET / IP Tool

Set up IP Addressing Details

With the IQ5 selected in the IPTool devices list, check the following parameters and set as required.

IMPORTANT: The Network Key, lan and node parameters MUST be set.



Click the WRITE DATA button to save the new settings.

Note: If parameters indicated * above are changed the IQ5 will reboot when the new values are saved.

STOP!

It is recommended that you complete the above setup for all IQ5 controllers in the Trend network before

proceeding.

Record the Address Details of the Controller



Device address (O/S)

LAN number

Fixed IP Address or Hostname (if DCHP)

Check LAN OK Indicator (not applicable if being used in NC Mode)

Normal operation indication

LAN built OK with at least one other device.

Attempting to build a LAN with other devices that have the same LAN number and N
etwork Key. This may take several minutes.

Controller set to standalone mode and will not build a LAN with other devices.

Fault indication

If this continues to show for more than a few minutes this indicates that the controller
has not found any other devices on the same LAN. Use IPTool to check device setti
ngs.

Connect to the Trend Network using I QSET

Using the Engineering PC/Laptop (see step 7) run IQSET and make a connection to the Trend Network (or



Site). For example:

IQSET Manual (TE200147)

Open a new site (e.g. File > Open/New Project > Live Site).

In the IQSET System View panel right-click on Sites and select New Site.

Select Trend as the network type and click OK.

Enter a Site name and click Edit site details. The Connection Wizard will appear.

Select Launching TUA Editor and click Next. The TUA editor will appear. Select the CNC tab:

Select TCP/IP, enter the IP Address (or hostname) of an IQ5 and add at least one valid vCNC port in the

Remote IP port list.

Note: If using a hostname and DNS or LLMNR is not supported on the network, add ‘.local’ to the hostname

and ensure that IQSET is connected to the same segment.

Click OK twice.

In the System View panel, double-click the site name in the Sites tree:

If the IQ5 (to which you are connecting) already has a System Account set up, then you will now be asked to

login using the appropriate credentials – go to step 20 on page 9.

Otherwise, you will be prompted to press the controller’s service button to validate the connection – go to step

19.

Validate the Connection to IQ5 and Create System Accounts



If you attempt connection to an IQ5 that has no system accounts setup, then IQSET will display:

Press the service button   on the controller within the specified time limit:

IQSET will now display a dialogue box for you to enter an Account Name, Password and Email address

for the Admin system account.

Note: The email address is required in order to recover from a forgotten password.

Click   to create the account.

You will then be given the option to create a single Engineer system account – click Yes or No as

required.

The new system account(s) will now be set up on the controller and synchronized with all other IQ5

controllers on the same Trend network, i.e. any IQ5 controller that has:

the same Network Key and UDP Port set up, and no pre-existing system accounts.

This will take a few seconds to complete, after which time IQSET will display a login box – go to step 20

on page 9.

Note: To add further system accounts go to the System View in IQSET, right-click the site, select System

Account Manager and follow the instructions in the IQSET Manual.

IQSET Manual (TE200147)

Remember to provide the credentials of the Admin system account plus the Network Key to the site

owner to enable them to manage the system accounts. If the site owner does not have access to IQSET

you may need to add another Admin system account for each system integrator working on the site.

Login to the Trend Network

If you attempt connection to an IQ5 that has system accounts setup, then IQSET will display:



Enter the User Name and Password for a valid Admin or Engineer system account.

Click OK.

In the System View panel click the site name to refresh the site details (or right-click and select Refresh).

Create Strategy in IQSET
Create an IQSET project and create a strategy for each IQ5 controller.

In IQSET click File > Open / New Project.

Select Create New SET Project and click OK.

Enter the required details and click OK.

In the Project View panel add the required LANs by right-clicking the project name and selecting Insert Lan.

Enter the required LAN Number and Label, and click OK. Note: The LAN number should match the LAN(s)

defined using IPTool in step 15.

Add the required IQ5 controllers by right-clicking a LAN and selecting Insert Device > IQ Controller. The

Controller Selection dialogue appears:



Select IQ5 and select the required number of I/O points (I/O Total) and licensable features (Options) and click

OK.

In the Device Details dialogue enter the controller Address and Name, and click OK.

Note: The Address should match the node(s) defined using IPTool in step 15.

In the Address Module dialogue enter any required settings and click OK.

In the Sensor Type dialogue enter any required settings and click Exit.

Set up IO Modules (if installed)

▪ Right-click in the empty strategy page and select Device > I/O Setup.

▪ In the I/O Setup dialogue add and configure any IO Modules as required by following the instructions in the

IQSET Manual.

Configure Remaining Strategy (as required)

Create the remainder of the strategy by following the instructions in the IQSET Manual and IQ5 Configuration

Manual.

Local User Modules

It is not necessary to create local User Modules for the IQ5, unless these are required to control end users

access to the web interface or the IQVIEW SCD (single controller display).

All engineering access is controlled by the system accounts created in step 19.

Set up IQ5 Feature Licencing
If any licensable features are required (e.g. additional IO points, NC or INT functionality) these must now be
enabled.

With IQSET connected (see step 18) and logged in (see step 20), go to System View.

Right-click the site name in the Sites tree and select IQ5 Feature Licensor.

Select the device(s) required and click    to generate a Licence Request File and save it on the PC.

 Login to the HBT Licensing Portal:

https://MyBuildings.honeywell.com

Select Quick Cart and upload the License Request File.

Add any additional details including the email address of the person requiring the licence, then checkout the

order.

After the order has been processed an email will be sent to the specified email address. You will then need to…

Download the Licence File from the Portal and save it.

Using the IQ5 Feature Licensor click   to import the Licence File.

Select which device(s) to update.

https://mybuildings.honeywell.com


Click   to update the device licenses.

Note: If you are not connected to the same IQ5 vCNC that was used when creating the Licence Request File a
warning will be displayed. If you are connected to the same site you can ignore the warning. If you are not
connected to the same site connect using a different connection.

Set up NC Communication Mode (if the IQ5 is required to operate as node controller)

Note: The IQ5 must be licensed for NC mode.

Using the Engineering PC/Laptop (see step 7) open a compatible web browser and access the IQ5 web

interface using its IP Address or Hostname.

If prompted, login using valid system account credentials.

Select Modules > Networks to display the NC Configuration Wizard.

Click required mode icon (see table), and if necessary specify any parameters, e.g. LAN number.

Note: If no icons appear, check that the IQ5 is configured and licensed for NC operation (see step 21 & 22).

Click   ; the controller will now reboot.

Set the communications channel on the MS/TP network module to the port the MS/TP network is connected to.



Note: In NC mode the IQ5 always has a LAN to connection to the internetwork and so cannot join another LAN

on the internetwork.

Configure or Disable the Web Server (if required)

The IQ5’s web server enables users to access the web interface for viewing/changing module parameters

(including setting up NC mode – see step 23) or interacting with optional

GraphIQ pages via a web browser.

Connection to the IQ5’s web server can be made via HTTP and/or HTTPS protocol and both these ports are

enabled by default.

Note: Where HTTPS is used it will be necessary to configure SSL certificates (see the IQ5 Configuration

Manual).

If access to the web interface is not required it is recommended that both ports are disabled for security.

For example:

Using the Engineering PC/Laptop (see step 7) open a compatible web browser and access the IQ5 web

interface using its IP Address or Hostname.

If prompted, login using valid system account credentials.

Select Modules > Networks.

Select n1 (Ethernet IP).

Set the Web Server Port Number and/or Secure Web Server Port Number parameters to 0 to disable the

port.

Click  

Download Strategy to IQ5 Controller
Use IQSET to download the strategy to the controller(s).

For a single controller.

Select the appropriate controller/strategy in the Project View.



From the Strategy menu select Create Data File.

In the System View select the appropriate controller.

Right-click the controller and select Send File to Device.

In the File Download dialogue box check that the correct file is selected the in Transfer Directory field.

Click   to start the download.

For other methods or for downloading to multiple contollers please refer to the IQSET Manual

IMPORTANT: The controller’s date and time MUST be set correctly to ensure that the controller’s security

certificates can be correctly validated. Communications issues will occur if the security certificates are not

valid. This can be done by selecting the option to set the controller’s time is selected when downloading the

strategy.

Note: If the strategy uses an NTP server to set the IQ5’s time and date, synchronisation will only occur if the

IQ5’s time and the server’s time are within 49 days of each other.

Note: The controller’s date and time may be set up from a controller configured as timewaster.

Check RS-485 Network Indicators (if RS-485 devices are connected)

Normal operation indication

Port configured OK and communications are good.

Port not active. No Network module exists in the controller strategy or is not configured correctly.

Fault indication

No communications or no network connected.

Note: A controller configured for NC operation will show   on port 1 until BACnet devices are connected.



Check Status Indicator of T1L IO Bus Modules (if connected)

Setting the Address of a Module
The IQ5 controller will automatically attempt to match each physical I/O module with its corresponding strategy I/O
module and set its address accordingly.

However, the controller will be unable to set the address of a module if:

there is more than one unaddressed physical module of the same type,

there is more than one unaddressed strategy module of the same type, or

there is no corresponding I/O module in the strategy.

Should any of the above situations arise it will be necessary to set the address of any affected module using
either of the following methods.
Method 1: Use the IQ Tool Soft Addresser Applet in IQ®SET.

IQ Tool Soft Addresser Applet Manual (TE201356)

Use the applet to assign the physical I/O module to the appropriate strategy I/O module.

Method 2: Use the controller web interface.



IQ5 User Guide (TE201490)

Login to the controller’s web interface.

Access the I/O Module page and enter module addresses as required.

Note: If a module is not visible in either the applet or the web interface, it may be because it has already be used
with another controller. A module becomes bound to the first controller it connects to over the T1L bus. If
connecting the module to a different controller it will need to be reset as shown in section 7 on page 20.

Identifying a Module using the ‘Wink’ Function (if required)
To help identify a specific module it can be placed in ‘wink’ mode, either from the module itself or set up tool. While

in wink mode the module’s service indicator  will flash and the status indicator ring of the
corresponding controller will also flash green.

Method 1: Use the module’s service button..

Press the module’s service button  briefly (<3 seconds). The module’s service indicator 

 will flash for approximately 2 minutes, showing that the device is in wink mode.

Open either the IQ Tool Soft Addresser Applet or the controller’s web interface (see Method 2 and 3).

Any module in wink mode will have its Wink parameter set to ‘On’.

Method 2: Use the IQ Tool Soft Addresser Applet in IQ®SET.

IQ Tool Soft Addresser Applet Manual (TE201356)

Click the button for the appropriate module   button for the appropriate module.

The button background will flash green and the module’s service indicator    will flash, showing

that the device  is in wink mode.

Click the button again to turn off wink mode.

Method 3: Use the controller web interface.



 IQ5 User Guide (TE201490)

Login to the controller’s web interface.

Access the I/O Module page.

In the Wink column set the parameter to ‘On’ for the appropriate module.

The module’s service indicator   will flash, showing that the device is in wink mode. It will

continue to flash until the corresponding Wink parameter is set back to ‘Off’.

Switch Off Controller (including additional I/O Bus PSUs)

30 Reconnect Inputs

CAUTION: Check that each input connection is appropriate for the IO module input type. For example, ensure

that a mains voltage is not applied to a low voltage input.

Switch On Controller & Input Supplies (including additional I/O Bus PSUs)



Check Input Operation

IQ4/IO Modules

IQ4/IO/.. Installation Instructions – Configuring (TG201161) Section 4 Only

XCITE/IO Modules

XCITE/IO/.. Installation Instructions – Configuring (TG200627) Section 4 Only

Switch Off Controller & Input Supplies (including additional I/O Bus PSUs)



Backup Strategy

Once the system is working as expected, it is good practice to upload the strategy from each controller into

IQSET to create a backup.

If required, you can also compare this uploaded strategy with that held in your project and check for any

differences.

 IQSET Manual (TE200147)

Install Supervisors or Displays (if required)

If a supervisor or local display is required, install these now following the appropriate installation instructions

and the guidance notes below. Otherwise go to step 32 on page 18.

Connection requires a vCNC to be configured on the target controller.



To make a connection with IQSET or supervisor ensure that a vCNC is available in a Trend device on the same

Ethernet Trend network and connect to the vCNC as described in the supplied documentation.

Note: If connecting with IP Tool, the PC should be on the same Ethernet segment as the IQ5.

To make a connection with a web browser run the web browser on the PC and access the IQ5’s IP address or

host name.

To make a connection with an IQVIEW SCD, install the IQVIEW SCD application on the controller, then

configure the display device with the URL of the IQ5 controller. For full details see IQVIEW Single Controller

Display for IQ5 Manual (TE201504).

Direct Connection via USB Engineering Port

This method is only suitable for a temporary connection with IQSET during system commissioning or fault finding.

Close Panel / Enclosure

The configuration procedure is now complete!



RESET IQ5 CONTROLLER TO FACTORY DEFAULTS
A factory reset will erase the strategy and reboot the controller into its default configuration.

Isolate Power and Disconnect All I/O
Follow steps 1, 2, 4, 8 and 9 (on pages 1 to 4) to:

Isolate Power,

Open Panel,

Disconnect All I/O,

Unplug all Ethernet cables. Any RS-485 networks may be left connected,

Switch on power to IQ5 only,

Wait for controller to settle.

Perform the Reset

Press and hold down the service button  (located behind the drop down flap) until the ring indicator

flashes yellow, then release the button. To initiate the reset press the button again while the indicator is still

flashing.

The reset process may take up to several minutes depending on the controller type. Do not remove power to

the controller until the process has completed.

While the controller is erasing the strategy, the ring indicator will remain yellow and appear to ‘rotate’. When the

reset is complete the controller will reboot as shown in step 9 on  page 4.

The strategy, user modules (passwords, etc), alarm logs, and plots records are cleared down, and all other

parameters will be returned to their default settings as shown in step 15 on page 7.

Note: Time and date are left at their current values, and the license is not affected by the reset.



RESET IQ5-IO MODULE TO FACTORY DEFAULTS
A factory reset will erase all input/output settings and module address and reboot the module into its default
configuration.

Isolate Power and Disconnect All I/O from the Module
Follow steps 1, 2, 4, 8 and 9 (on pages 1 to 4) to:

 Isolate any power supplies used by the module inputs or outputs,

Open panel,

Disconnect all I/O from the module,

Isolate the module power supply.

 Perform the Reset
With the module powered up, use the service button to initiate the reset process as follows:

The reset process will only take a few seconds depending on the module type. Do not remove power to the

module until the process has completed.

When the reset is complete the module will reboot and the controller will attempt to re-address the module as

shown in step 1 on page 14.



Reconnect Inputs & Outputs and Check Operation
Follow the guidance from step 27 on page 12, through to step 31 on page 17.

 Please send any comments about this or any other Trend technical publication to

techpubs@trendcontrols.com
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